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1. About GingerALE
GingerALE is used for performing activation likelihood estimation (ALE)
meta-analyses. The ALE meta-analysis method was initially developed by
Peter Turkeltaub (see Turkeltaub et al., Neuroimage, 16, 765-780, 2002
for details). This method of meta-analysis was adopted by BrainMap in
2003. Several modifications have been made to the ALE algorithm since
then, and the current version of our software is reported in Eickhoff et al.,
Hum Brain Mapp 2009 (full text available on www.brainmap.org/pubs).
Users now have a choice of running their meta-analyses in MNI or
Talairach space.

2. Performing ALE Meta-Analyses
All output files are written in NIfTI (.nii) format. The input for a metaanalysis in GingerALE is a text file of your foci, generated by hand, from
an excel worksheet, or as an export of your workspace in BrainMap
Sleuth. To load these coordinates into GingerALE, go to File  Open Foci.
The main window of GingerALE will then confirm for you the name of
your foci file and the number of coordinates and experiments contained
therein Fig.1.

Figure 1. GingerALE: Open Foci.

If you used Sleuth to create a foci file from your workspace, then there
is no need to spatially renormalize your MNI coordinates to Talairach
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space (or vice versa). This conversion is done automatically when the
papers are inserted into the database using a transform called icbm2tal
developed by Jack Lancaster (see Lancaster et al., Hum Brain Mapp, In
Press, 2007 for details). This new transform provides improved fit over the
Brett transform (mni2tal). Please note that we no longer use the Brett
transform for conversion of coordinates from MNI space to
Talairach space.
The ALE meta-analysis procedure follows 3 steps:
2.1. ALE and Testing Significance Fig.2: This step computes the ALE values
for each voxel in the brain and performs a test to determine the null
distribution of the ALE statistic at each voxel. We no longer require
manually entering the FWHM value, as this parameter has been
empirically determined (see Eickhoff et al., 2009 for details). A default
file prefix is given for the name of the output files, based on the name
of your foci file; you may edit this if you like. Then click on “Compute”
and the program writes out an image containing the ALE values
corresponding to your foci file, and another image of P values at each
voxel.

Figure 2. GingerALE: ALE and Testing Significance.

2.2. Thresholding Fig.3: This step takes the P values from the previous
step and computes the threshold for the ALE map using the algorithm
from Tom Nichols's website (http://www.sph.umich.edu/~nichols/FDR/).
Choose a False Discovery Rate (q) for the desired level of significance
(e.g., 0.05 or 0.01). Also choose a minimum cluster size in mm3. This
step creates the final thresholded ALE map (final output). Only voxels
that were found to be statistically significant are assigned a value. The
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value that is written out is the computed ALE value. The thresholded map
is output in .nii format and can be read by a number of functional
neuroimaging software packages.

Figure 3. GingerALE: Thresholding.

2.3. Cluster Analysis Fig.4: This step performs cluster analysis on the
thresholded map, based on the minimum volume that is specified in the
previous step. Anatomical labels of final cluster locations are provided by
the Talairach Daemon: http://ric.uthscsa.edu/TDinfo.

Figure 4. GingerALE: Cluster Analysis.

2.4 Viewing Your Results: Once the thresholded map has been created,
you'll need an anatomical underlay in order to view the meta-analysis
results. We distribute two templates in Talairach space (one general file
and one to be used in AFNI) and one MNI template on GingerALE’s
website (www.brainmap.org/ale/index.html).
Although our .nii files are
compatible with most image viewing software, we suggest using Mango to
view your meta-analysis results (www.ric.uthscsa.edu/mango/). For metaanalyses performed in Talairach space:
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a) Download and open Mango.
b) Open → Open Image → select the Colin1.1.nii file that’s available on
www.brainmap.org/ale (or you may choose the MNI template).
c) In the brain image that pops up, click on File → Add Overlay → and
select the ***_p05.nii image that you created in the penultimate step of
GingerALE. This overlays your functional meta-analysis results on top of
the anatomical template.
d) Click on Edit → Update Image Range (very important!)
e) To change the color map, go to the smaller rectangular window and click
on the red box on the left side, move your cursor down to the next red
box, move to the side text box that pops up, move to “Color Table”,
then click on your preferred color option (Red-to-Yellow and Spectrum
are good for ALE results).
f) Moving your cursor throughout the brain will move you through space.
Pressing the spacebar will change the orientation of the biggest image
(axial, coronal, sagittal).
g) Options → Select Atlas → Talairach Daemon Labels (hit OK in window
that pops up) will then give you the anatomical labels of your current
location in brain space, as well as the coordinates.

To get the ALE values for all voxels (even ones not found to be
significant), you'll need to open the file created in the first step, Fig.2, of
the ALE meta-analysis process.
2.5 Citing GingerALE: If you use the above software, procedure, and/or
template in your research, please acknowledge our previous work in any
resultant publication:
Laird AR, Fox M, Price CJ, Glahn DC, Uecker AM, Lancaster
JL, Turkeltaub PE, Kochunov P, Fox PT. ALE meta-analysis:
Controlling the false discovery rate and performing statistical
contrasts. Hum Brain Mapp 25, 155-164, 2005.
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3. Main Menu Items

Figure 5. The Main Application Menu.

3.1 GingerALE
3.1a About GingerALE: This menu item contains basic information about
GingerALE, such as the homepage, version number, and copyright date.
3.1b Preferences: The menu item addresses certain settings that are
relevant to performing ALE meta-analyses. This information is divided
into three sections: Mask Options, Default Values, and Output Files.
Coordinate Space ➊,Fig.6:
A radio button is available to select which standard space the metaanalysis should be performed in: Talairach or MNI.
Mask Options ➊,Fig.6:
When a foci file is opened, the coordinates are compared against a mask
defining the outer limits of Talairach (or MNI) space. A pop-up window
will appear if any of your coordinates are located outside of this mask.
The ALE analysis will proceed after this step without any intervention on
your part. However, any coordinates located outside of this mask will not
be omitted from subsequent analysis and might possibly yield strange
activations on the border of your mask that do not appear to have a
center of mass.
Normally, finding coordinates outside of the mask will occur for less than
3% of your total foci (we have found this number to be even lower since
implementing the Lancaster transform instead of the Brett transform).
Finding coordinates located outside of the mask is sometimes due to
author error (e.g., missing negative sign, inverted coordinates, etc.). You
can often spot this type of error and correct for it manually. For example,
if a coordinate is listed as being located in the occipital cortex, but the
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given y value is positive and extends outside of the Talairach mask, then
we recommend that you change the y value from positive to negative
before proceeding with the ALE analysis.
Two options are available for your mask size, a smaller mask or a larger
mask. Typically, we use the smaller mask for meta-analyses of functional
imaging studies. The larger mask is available for VBM meta-analyses
because many reported coordinates in these studies are located on the
outside of the brain. We slightly enlarged the mask for these metaanalyses so as to include more foci located at the boundaries of
Talairach or MNI space.

➊
➋

➌

Figure 6. ALE Preferences.

If you have a large number of outlying foci that you do not want omitted
from your meta-analysis, then you can select the option of “Less
Conservative (Larger)”. This option will slightly increase the default mask
size, thus including a wider range of coordinates. An image of the
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difference between the two mask files for the Talairach template can be
seen in Fig.7. In this difference image, the white areas denote the extra
voxels included when using the larger (less conservative) mask file. Please
note that if you use this larger mask, some of your resultant ALE clusters
may appear to be located outside of the brain when viewed on the
colin.nii anatomical template.

Figure 7. Difference Between Mask Size Options.

Default Values ➋,Fig.6:
You may set default values for the False Discovery Rate, pN or pID, and
minimum cluster volume (mm3). These values may be changed at any
time in the main window of GingerALE for a specific meta-analysis;
however, you may set your most commonly used default values here for
convenience.

GingerALE Users’ Manual - 10

The computation for the false discovery rate will yield two P value
thresholds. The RIC generally uses thresholds returned by pN. If you
prefer pID, you can set it as the default thresholding value in the
Preferences. See Genovese et al., Neuroimage, 15, 870-878, 2002 for
more details.
In this section you may also choose if you which coordinates to be
reported for all submaxima in a single ALE cluster (“All extrema”) or only
one coordinate for the maximum ALE statistic in that cluster (“One
extrema”).
Choosing the former option is very useful for large ALE
clusters that extend over many different areas of the brain.
Output Files ➌,Fig.6:
Lastly, you may specify the output directory for all of your processed
ALE files, which files you want to output, and what your preference is for
pop-up windows about boundary foci and overwriting files.
A number of files may be written to output during the ALE procedure. We
recommend that all of these options be checked.
1. ALE Image = contains the unthresholded ALE values, one computed
at every voxel in the brain
2. P Value Image = contains each voxel’s P value, corrected for
multiple comparisons using FDR
3. Thresholded Image = ALE maps thresholded at a given α value;
this is the final image output by GingerALE.
4. Cluster Image = thresholded ALE map, each cluster given an integer
€
value; this image is required for subsequent FSNA/RDNA
analyses.
5. Data History = reports the analysis parameters and the output of
the cluster analysis on the thresholded ALE map in text format
6. Cluster Spreadsheet = excel doc of cluster analysis on thresholded
ALE map
In the data history and cluster spreadsheet files, the cluster analysis
reports a variety of information. In the cluster spreadsheet, you will see
10 columns of information. From left to right these are:
(1) cluster number
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(2) volume of cluster in mm3
(3-5) x,y,z values of the weighted center of mass of the cluster
(6) maximum ALE value observed in the ALE cluster
(7-9) x,y,z values of the location of the maximum ALE value
(10) Talairach Daemon anatomical label associated with the location of
the maximum ALE value.
All of this information can be found in both the data history and cluster
spreadsheet files. The data history file also includes information on the
x,y,z values for the extent of each cluster and reported parameters for
different stages of the analysis, such as computing the ALE statistic,
performing the permutation test, running FDR and thresholding the ALE
map.
3.2 File
Open Foci: This menu item loads in a text file of coordinates into
GingerALE. Hotkey: ⌘-O (Mac) or ctrl-O (PC). The format for this file
should be three columns of numbers (x,y,z coordinates), separated with
tabs or spaces. If you created your foci file in Sleuth, the experiments will
be separated by a line break and delineated by first author name, year,
and experiment name (“//” comments these descriptors out so that they
will not be read by the ALE algorithm). Between the commented
experiment name and the list of coordinates, you should also include a
line that details the number of subjects for that group of foci.
For
example, your foci text file should look like:
// Sadato, 1998: Rest-Discrimination
//Subjects=18
-18
16
56
-12
52
4
-22
56
12
30
-84
-12
44
-70
0
-24
-94
0
-8
-98
-12
18
-70
-8
-6
-44
56
16
-46
52
0
16
-8
-46
32
4

GingerALE Users’ Manual - 12

// Rosen, 1999: Rest > Endogenous
//Subjects=13
4
-70
31
8
-35
69
-2
-87
2
3
-85
6
-6
-56
19
-55
-10
10

Clear Foci: This menu item clears your foci from GingerALE.
Save Data History: This menu item allows you to save a text output that
summarizes your ALE meta-analysis at any point in the procedure.
Please Note: With the advent of the new Eickhoff algorithm, GingerALE
no longer supports comparison or subtraction meta-analyses, such as
those published in Laird et al., Hum Brain Mapp, 25, 155-164, 2005. We
are working hard to update our software to include these comparisons.
In the meantime, users will need to revert to an older version of
GingerALE if they need to perform a comparison or subtraction metaanalysis. Also, due to the new analytic solution to computing P values,
GingerALE no longer allows you to reopen saved files of ALE scores or P
values.
3.3 Tools
Export Foci Image: This menu item creates an .nii image of your foci
file. In this image, each coordinate point is assigned a value. No blurring
of the coordinate points is performed in this export – this step is simply
intended as a way to view your coordinates in standard space. The value
assigned to each coordinate point matches the experiment number of
your foci file. Remember, different experiments are defined in a foci file
simply by including a line break between the groups of foci. By assigning
values in this way, it is easy to set each experiment number to a
different color in your image viewer so that you can identify the paper
and experiment for each coordinate point as you scroll through the brain.
If 2 identical coordinate locations are included in different experiments,
then the value assigned to that voxel will be n+1, where n equals the
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number of total experiments. This is done so that these duplicate
coordinates can be seen on the resultant output image.
Convert Foci: This menu item uses a dialog window Fig.8 to guide you
through the conversion of your coordinates from MNI space to Talairach
space and vice versa. You are given options for selecting your input file
of coordinates, the transform you would like to use, and the name and
location of your output file.
There are 8 coordinate transforms included in GingerALE:
The first three transforms convert coordinates from MNI space to
Talairach space using the Lancaster transform, icbm2tal. This transform is
broken into 3 options, based on what software you used for spatial
normalization of your data (SPM, FSL, or Other):

(1)
(2)
(3)

MNI (SPM) to Talairach
MNI (FSL) to Talairach
MNI (Other) to Talairach

The second three transforms perform the corresponding transforms from
Talairach space to MNI space using the Lancaster transform. Again, this
transform is broken into 3 software options:
(4)
(5)
(6)

Talairach to MNI (SPM)
Talairach to MNI (FSL)
Talairach to MNI (Other)

The last 2 transforms are reproductions of the Brett transform, mni2tal.
Two options are given for the Brett transform, one for converting from
MNI space to Talairach space, and the other for converting from
Talairach space to MNI space:
(7)
(8)

Brett: Talairach to MNI
Brett: MNI to Talairach
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Figure 8. Transforming Coordinates: MNI and Talairach Spaces.

Although the BrainMap database no longer supports use of the Brett
transform, we feel it is still important that we include it in our software. If
one of the studies included in your meta-analysis generated its
coordinates by using SPM for spatial normalization and published those
coordinates after conversion using the Brett transform, then we
recommend that you “un-Brett” the published coordinates using the above
transform “Brett: Talairach to MNI” and then proceed with the Lancaster
transform “MNI (SPM) to Talairach”. This will correctly move your
coordinates into the Talairach space.
3.4 Help
Check for Updates: This menu item will check the BrainMap website to
see if you have the latest version of GingerALE.
Show Manual: This menu item will show the current manual for GingerALE
(this document). An internet connection is necessary for this menu option.
Show Read Me: This menu item will show the current readme file for
GingerALE. The readme file contains information about installation and
version changes. An internet connection is necessary for this menu option.
Show License: This menu item will show the current license information
for GingerALE. An internet connection is necessary for this menu option.
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4. Troubleshooting
4.1 What are the minimum number of papers needed to perform an
ALE meta-analysis?
There's no definitive answer to this question. For paradigms that involve
simple sensory processing (e.g., passive listening), you only need a
handful of coordinates (approximately 20-30) since that type of paradigm
tends to only activate a few areas (e.g., primary, secondary auditory
cortices, etc). But for a cognitive task like the Stroop task or the n-back
task, a wider network of activations is expected. Thus, you'll need a
higher number of input coordinates in order to see substantial
convergence (at least 100 foci or so). These are VERY loose estimates,
but it should give you an idea of what you should be looking for when
performing your literature search. Lastly, please keep in mind that it really
depends on how varied the results are for your particular paradigm or
domain. For example, TMS/PET studies vary widely and their results do
not overlap nicely. In contrast, verb generation tasks are highly
concordant and produce a very robust ALE meta-analysis map.

